Structural Items

Well, I can’t avoid the topic of structure forever. You need to consider your structure from pretty much the beginning of the project, so I had better add it to the first half of the book before getting too carried away!

This chapter covers the following topics:

▶ Adding structural grids
▶ Adding structural columns
▶ Using structural framing
▶ Understanding foundation systems
▶ Adding structural footings
▶ Using structural views

Adding Structural Grids

Now that the full Autodesk® Revit® Architecture, Autodesk® Revit® Structure, and Autodesk® Revit® MEP applications have been blended together into one complete application with no separate, stand-alone applications for the different trades, you, the architect, have the same full spectrum of structural tools as your structural consultant. How far you delve into the structural design of your projects is between you and your structural consultant.

This chapter explores the structural world by presenting the basic functions of structural architecture. The first item you’ll tackle is usually the first item in the model: structural grids. Although you add structural grids line by line, you’ll soon discover that these grids are just as smart as the rest of Revit. The starting point for all things structural is most certainly the grid. In Revit, you’ll quickly find that placing a structural grid into a model isn’t a complicated task. Grids are essentially placed one line at a time. Those lines you place, however, have intelligence. For example, if you place a vertical grid line called A and then place a horizontal grid line called 1 that
intersects with A, you’ll have a grid location. If you place a column at that intersection, the column will assume a new property called Location. That location is—you guessed it—A-1.

Let’s get started. To begin, open the file you’ve been using to follow along. If you didn’t complete the previous chapter, go to www.sybex.com/go/revit2017ner, browse to Chapter 8, and find the file called NER-08.rvt.

### Placing a Grid

Placing a grid means drawing grid lines one by one. You can copy grids to speed up placement and array them if the spacing is regular. This task sounds tedious, but it’s a welcome change from other applications that force you to create an entire, rectangular grid, which you have to keep picking at until it resembles your layout. Grids are like snowflakes: no two are the same.

**NOTE** Metric users should not type in \textit{mm} or other metric abbreviations when entering amounts suggested in the exercises. Revit will not accept such abbreviations. Simply enter the number provided within the parentheses.

To place a grid, follow these steps:

1. In the Project Browser, go to the Level 1 floor plan. (Make sure you aren’t in the Level 1 ceiling plan.)

2. Zoom in to the east wing’s radial entry.

3. The Datum panel that holds the Level and Grid tools appears on both the Architecture and Structure tabs. On the Datum panel of the Structure tab, click the Grid button, as shown in Figure 8.1.

4. On the Draw panel of the Modify | Place Grid tab, click the Pick Lines icon, as shown in Figure 8.2.
5. Pick the centerline of the north wall (see Figure 8.2).

6. The grid bubble needs to be moved. Press Esc twice, or click Modify (to clear the command) and select the grid bubble. Notice the round blue grip similar to that in Figure 8.3.
7. Pick that round blue grip, and drag the column bubble to the right about 50' (15,000 mm), as shown in Figure 8.4.

![Figure 8.4: Dragging the column bubble to the right](image)

8. On the Datum panel, click the Grid button again.

9. On the Draw panel, click the Pick Lines icon if it’s not picked already.

10. Pick the core centerline of the interior wall that terminates at the exterior wall, as shown in Figure 8.5.

![Figure 8.5: Adding the second grid line](image)
11. Drag the right end of the line to align with grid 1. It snaps weakly. After you move your line to the length of grid 1, pick the second point. An alignment line appears.

**TIP** Alignment lines, however useful, can be tricky to get to display. The percentage of your zoom has an effect. If you aren’t getting the alignment lines, simply zoom back (or in) a small amount, and they will appear.

12. If the grid bubble doesn’t appear on the right side as shown, but rather on the left side, find the blue check box on the right side of grid 2 and pick it. Doing so turns on the grid head.

13. On the left side of grid 2 are a grid bubble (see Figure 8.5) and the same blue check box. Click the check box to turn off the grid head at this location.

14. Press Esc.

Being able to pick lines is certainly an advantage, but you won’t always be in a situation where you have geometry in place to do so. In the following procedure, you’ll add grid 3 by picking two points:

1. Click the Grid button on the Architecture tab.

2. On the Draw panel, select the Line icon.

3. Pick a point along the center reference plane, as shown in Figure 8.6.

**Figure 8.6:** Adding grid 3 at the center of the building
4. Pick a second point in alignment with grid 2 (see Figure 8.6).

5. Add grids 4 and 5 to the exact opposite ends of the east wing (see Figure 8.7).

![Figure 8.7: The completed horizontal grids](image)

You need to add two more grids at 45° angles. This will be as easy as drawing lines. The objective here is to manipulate the grids to read the appropriate numbering.

1. On the Architecture tab, click the Grid button if it’s not selected already.

2. Pick the center of the radial wall.

3. Draw the line at a 45° angle until you're beyond the radial wall, as shown in Figure 8.8.
4. Click in the bubble for the angled grid, and rename the grid line 2.1. You can do this while placing grids. Click outside the grid number field to enter the change.

5. Draw another grid line at a 45° angle in the opposite direction.

6. Renumber it to read 3.9 (see Figure 8.8).

**NOTE** In many instances, you’ll encounter elevation markers and other annotation items that get in the way. You can move these items, but be careful. After you move an item, open the referring view to make sure you didn’t disturb anything.

You need two more horizontal column lines that span the length of the building. You’ll number these lines 2.10 and 3.1. They will run centered on the corridor walls. To do this, you’ll use the Pick Lines icon on the Draw panel. Here are the steps:

1. On the Architecture tab, click the Grid button if it’s not selected already.

2. On the Draw panel, click the Pick Lines icon.

3. Pick the core centerline of the north corridor wall, as shown in Figure 8.9.
4. Pick the blue grip at the end of the line, and stretch it to align with the already-placed bubbles, as shown in Figure 8.10.
5. Click the Show Bubble button if necessary.

6. Rename the grid 2.10 (see Figure 8.10).

7. Zoom to the other end of the grid line, and deselect the Show Bubble check box if necessary.

8. Repeat the process for the south corridor wall, adding an additional grid line numbered 3.1, as shown in Figure 8.11.

The grids are laying out OK, but it looks like you should make some adjustments to move the bubbles apart a little. You can do this by adding an elbow to the grid’s end.

**Adding Elbows**

As with levels, you can add a break in the line of the grid, allowing you to make adjustments as if the grid were an arm with an elbow. Follow these steps:

1. Click Modify. Select grid 2.10.

2. Several blue grips appear. Pick the one that appears as a break line, as shown in Figure 8.12.
3. Picking this break line adds an elbow to your grid line, as shown in Figure 8.13.

![Image](image1)

**FIGURE 8.12:** Clicking the Add Elbow grip after selecting the grid

4. Repeat the procedure for grid 3.1. Your grids should now look like Figure 8.13.

5. Save the model.

**Note** Notice that the bubble was broken, and it was moved up and out of the way. This won’t always happen. In most cases, the grid will move in the wrong direction. You can then select the blue grips and move the bubble in the direction you intended.

It’s now time to add the vertical grids. This will be a simple process until you get to the radial entry area. At that point, you’ll need to do some additional manipulating of the grid.
Adding Vertical Grids

The only real issue with adding vertical grids is the numbering-versus-lettering issue, because Revit continues the sequencing from the horizontal grids. Make sure that when you add your first grid going in the opposite direction, you renumber (or rename) the first occurrence of the grid.

The objective of the next procedure is to create a grid pattern running vertically across the view.

1. Zoom out so you can see the entire east wing.
2. On the Datum panel of the Architecture tab, click the Grid button.
3. On the Draw panel of the Modify | Place Grid tab, click the Pick Lines icon.
4. Pick the centerline of the west exterior wall of the east wing (see Figure 8.14).

![Figure 8.14: Adding the first vertical grid by picking the centerline of the exterior wall](image)

5. When you pick the wall, the grid is added, but it doesn't have the name or number you want. You'll change that. But first, pick the round blue grip and drag the bubble up past the dimensions, as shown in Figure 8.15.
6. Press Esc.
7. Select the new vertical grid.
8. Click in the bubble, and rename it A, as shown in Figure 8.16.
Next, you'll duplicate this grid. Because you have an arsenal of modify commands under your belt, the best way to duplicate this grid is to copy it, as shown in the following steps:

1. Select grid A.
2. On the Modify | Grids tab, click the Copy button, as shown at the top of Figure 8.17.

![Figure 8.17: Copying the grid line to the other walls](image)

3. On the Options bar, make sure the Multiple check box is selected, as shown at upper left in Figure 8.17.
4. Pick a base point along the grid line within the wall (see Figure 8.17).
5. Copy grid A to the wall centerlines (see Figure 8.17). The grid lines auto-sequence as you go.
6. Press Esc twice.
7. Start the Grid command again.
8. On the Draw panel, make sure the Line button is selected.
9. Pick a start point at the endpoint of the radial wall, where it intersects with the straight wall, as shown near the bottom of Figure 8.18.
10. Pick the second point in line with the adjacent grid bubbles (see Figure 8.18).

11. Press Esc.

12. Pick the grip on the bottom of the line, and drag it down past the south part of the radial wall.

The next step is to add the grid to the radial entry area. This won’t be as easy as simply picking a wall’s centerline. The trick is to establish a reference point to place the grid and, subsequently, a column.

**Adding a Radial Grid Line**

Sometimes you have to think outside the box—literally. Because you have radial geometry with which you must contend, you need to add a radial grid as follows:

1. Zoom in on the radial entry of the east wing.

2. Click the Grid button on the Architecture tab, if the Grid command isn’t currently running.

3. On the Draw panel, click the Pick Lines button, as shown in Figure 8.19.
4. Type in an Offset value of 6” (150 mm) on the Options bar.

5. Pick the finished, inside face of the radial wall (see Figure 8.19). Make sure the alignment line indicating where the grid will go is on the inside of the wall.

6. The grid bubble lands in a congested area. Fix this by adding an elbow and adjusting the bubbles, as shown by grid G near the top of Figure 8.20.

One last thing you need to do is to make sure the grids extend all the way to the west side of the east building. This will play a major role when you start placing columns. Follow these steps:

1. Select grid 1.
2. Pick the grip icon to the left of the grid line.

3. Drag the grid to the left, past the west wall.

4. Repeat the procedure for grids 2, 2.10, 3.1, 4, and 5.

5. Repeat the procedure, stretching the vertical grids south. This will include grids A, B, C, D, and E. If you drag the lower end of grid A down, the copied grids B, C, D, and E will move with it. Make the lower end of grid F snap into alignment with the others.

I think you get the picture on adding grids. In the next procedure, you’ll begin adding columns to these grid intersections. To do so, you’ll explore the Structure tab on the Ribbon.

**Adding Structural Columns**

The hard part is over. Determining where to put the columns is more difficult than physically placing them in the model. But of course there are rules to follow, as well as rules you need to bend in order to accomplish the results you want to see.

This next series of procedures includes adding structural components to the model and placing framing systems in areas where a structural engineer may defer to the architect for structural integrity, given the design intent. (Try using that phrase in a meeting.)

To add columns to the model, follow this procedure:

1. In the Project Browser, go to the Level 1 floor plan.

2. Zoom into the radial entry area in the east wing.

3. On the Structure tab, choose Column ➢ Structural Column, as shown in Figure 8.21. This tool is also on the Architecture tab.

---

**FIGURE 8.21:** Column ➢ Structural Column on the Structure tab of the Ribbon
4. Click the Load Family button, as shown in Figure 8.22.

![Load Family](image)

**Figure 8.22**: You can click the Load Family button to add additional columns to your project.

5. Browse to US Imperial ➢ Structural Columns ➢ Steel (or Metric ➢ Structural ➢ Columns ➢ Steel).

6. In the Steel folder, browse to HSS-Hollow Structural Section-Column.rfa (or M_HSS-Hollow Structural Column.rfa).

7. Double-click HSS-Hollow Structural Section-Column.rfa (or M_HSS-Hollow Structural Column.rfa). A dialog opens, enabling you to select the type, as shown in Figure 8.23.

8. Select the HSS6×6×5/8 (HSS152.4×152.4×12.7) column.

![Column Selection](image)

**Figure 8.23**: Select HSS-Hollow Structural Section-Column.rfa, and choose the HSS6×6×5/8 (HSS152.4×152.4×12.7) type.
9. Click OK.

10. On the Options bar, make sure Height is set to Roof, as shown in Figure 8.24.

![Figure 8.24: Placing the column at grid intersection F-1](image)

11. Place the column at grid intersection F-1.

12. Press Esc twice.

13. Choose Column ➢ Structural Column on the Architecture tab.

14. Place a column at grid intersection F-2. Before you place this column, be sure Height is set to Roof.

15. Place another column at grid intersection F-G (see Figure 8.25).

![Figure 8.25: Placing the two additional columns](image)
16. Click Modify.

17. Select the column you just placed (column F-G).

18. In the Properties dialog, make sure Top Level is set to Up To: Roof, as shown in Figure 8.26 (just to check).

![Figure 8.26: Setting the column's top level to extend to the roof](image)

**NOTE** Notice that Column Location is set to F-G. This is important because if the column is offset from one of these lines, Revit still considers the column to be at that column location but with an offset dimension.

19. Mirror the three columns to the opposite side of the entry, using column line 3 as the reference plane.

20. Save the model.

Let’s add some full-height columns at the rest of the grid locations. You’ll begin with the radial grid and then place the rest of the columns in the walls of the exterior and the corridor. Here are the steps:

1. On the Structure tab, click the Column button.
2. On the Options bar, be sure Height is set to Roof.
3. Hover your cursor over grid intersection G-2.1. You can see the column, but it’s at the wrong orientation.

4. Press the spacebar on your keyboard, and the column rotates to align with the grid, as shown in Figure 8.27.

![Figure 8.27: Placing and rotating a column](image)

5. When the column is aligned, pick the intersection. The column is placed.

6. Repeat the steps for columns 3 and 3.9.

Now you’ll place columns in the main part of the wing. Place a column at every grid location. Note that you must stretch the column lines to the left side of the wing. You should also turn on the grid bubbles at the west and south sides of the building, as shown in Figure 8.28.
To add columns by intersection, follow these steps:

1. Start the Structural Column command.

2. On the Modify | Place Structural Column tab, click the At Grids button on the Multiple panel, as shown in Figure 8.29.

3. Pick a window around the rectangular portion of the east wing (from right to left), as shown in Figure 8.30.
4. The Modify | Place Structural Column ➤ At Grid Intersection tab changes to allow you to either finish or cancel. After you have the window placed, click the Finish button on the Multiple panel, as shown at the top of Figure 8.30.

5. Press Esc.

Quite a few columns are placed. You'll need to move some of them, including the four columns in the corridor intersection area. Revit will still locate each column at a grid intersection, but it will add the offset in the column's properties.

To move the columns and create a column offset, follow these steps:

1. Zoom into the middle of the east wing at the corridor intersection.

2. Select the two columns at the left of the corridor, as shown in Figure 8.31.

3. Move the columns 4'–0" (1200 mm) to the left (see Figure 8.31).

4. Repeat the same procedure for the other two columns (see Figure 8.32).
5. Zoom into the door shown in Figure 8.32.

6. Move the column to the left 4’–0” (1200 mm).

7. Thank your structural engineer for allowing this. The engineer is extremely understanding.

8. Save the model.
That’s enough on columns for now. It’s time to move on to adding some structural framing. You’ll add framing primarily in the canopy areas surrounding the east entry of the east wing.

**Using Structural Framing**

Although you won’t create much structural framing in Revit Architecture, you’ll need to add framing in a few areas. Canopies with light structural framing are certainly one area that could call for the architect to wander over to the structural side of the fence.

To begin adding structural framing, follow these steps:

1. In the Project Browser, go to the Level 2 floor plan.
2. Zoom into the radial entry area.
3. Select columns F-1 and F-5 (these are the columns outside the building).
4. In the Properties dialog, set Top Level to Level 2. (This makes the columns disappear for a moment.)
5. Press Esc.
6. In the Properties dialog, scroll down to the View Range row, and click the Edit button (see Figure 8.33).

![Figure 8.33: Setting the view range so you can see below the level](image)
7. In the dialog that opens, in the Primary Range section, set Bottom Offset to -1'–0" (-300 mm).

8. For View Depth, set Level Offset to -1'–0" (-300 mm), as shown in Figure 8.33.

**WARNING**  Be careful! Remember that when you make an adjustment to the view range, you’re changing the view range for the entire view. Be sure you aren’t inadvertently causing items on other floors to appear in the rest of the current view.

9. Click OK. You can now see the column.

Next, you’ll place the structural framing. Make sure you’re zoomed into the northeast corner of the east wing. Here are the steps:

1. On the Structure panel of the Structure tab, click the Beam button, as shown in Figure 8.34.

![Figure 8.34: The Beam button on the Structure panel of the Structure tab](image)

2. Click the Load Family button.

3. Browse to Structural ➔ Framing ➔ Steel.

4. Select HSS-Hollow Structural Section.rfa (or M_HSS-Hollow Structural Column.rfa). Click Open.

5. In the Specify Types dialog, select HSS6×6×5/8 (HSS152.4×152.4×12.7), and click OK.

6. Pick the first point at column E-1, which is buried in the corner of the wall.

7. Pick the second point at exterior column F-1, as shown in Figure 8.35.
Figure 8.35: Adding the beam requires picking two columns.

I Can’t See My Grids!

If your grids aren’t showing up on the second floor, do the following:

1. Go back to Level 1.
2. Select all of your grids.
3. Click the Propagate Extents button.
4. Select the floors on which you want to see your grids.

8. With the Beam command still running, pick the exterior column (F-1) and then column F-2, as shown in Figure 8.36.


10. Draw a beam 6” (150 mm) off the finish face of the wall, starting at the top beam and ending on column line 2, as shown in Figure 8.37. (This beam will later be supported by the framing within the building.)
Revit may think you’re bearing a beam on a nonbearing wall. If you’re asked to make this wall bearing, click Make Wall Bearing.
11. In the View Control bar, change Visual Style to Wireframe. This allows you to see the beam within the wall you’re about to draw.

12. Draw another beam from left to right, inside the wall, as shown in Figure 8.38.

13. Save the model.

**Why Is It Cutting Back the Beams?**

Well, that’s an inherent function of Revit. If you draw your framing to and from beam centerlines, Revit will keep the connection points in the correct locations but will trim back the beam for you. You can adjust these cutbacks by using the Beam/Column Joins tool from the Geometry panel of the Modify tab.

Now let’s add some filler beams. In Revit Architecture, you can add a beam system that is controlled by a specified spacing. After the system is in place, you can control the properties for the duration of the project.

**Adding a Beam System**

Although adding beam systems in Revit is much more crucial for structure, it’s useful for architecture as well. Having the ability to space a framing system equally can be quite advantageous.
To create a beam system, follow along with these steps:

1. On the Structure panel of the Structure tab, click the Beam System button, as shown in Figure 8.39.

![Figure 8.39: The Beam System button](image)

2. Make sure the Automatic Beam System button is picked, as shown in Figure 8.40.

![Figure 8.40: Selecting the Automatic Beam System and Tag On Placement options](image)

3. Click the Tag On Placement button (see Figure 8.40).

4. On the Options bar, make sure HSS6×6×5/8 (HSS152.4×152.4×12.7) is the Beam Type selection.

5. Change Layout Rule to Maximum Spacing, as shown in Figure 8.41. Set the distance field to 4′–0″ (1200 mm).

![Figure 8.41: Setting the maximum spacing and the tag style on the Options bar](image)
6. Change Tag Style to Framing.

**NOTE** The support you pick first determines the direction in which the beams will run. Notice the double lines in the horizontal beam? They indicate the direction of the beam system. If you want to change this direction, click the Beam Direction button on the Draw panel.

7. Hover your cursor over the top, horizontal beam, as shown in Figure 8.42. Notice the green dashed lines: this is where your beams will be placed.

![Figure 8.42: Getting ready to place the framing system](image)

8. When you see the green lines, pick the top beam, and your framing is placed (see Figure 8.43).

![Figure 8.43: The framing of the canopy](image)
9. Click Modify. Mirror the canopy to the other side of the radial entry. Be careful not to mirror the columns accidentally.

10. You may receive the message about bearing a structural member on a nonbearing wall. Click the Make Wall Bearing button.

By using the Beam System command, you can easily and quickly add multiple occurrences of framing members. In some cases, however, you need non-uniform members on a different plane, such as lateral bracing.

Adding Bracing

It would be nice to add a rod to the top of this canopy at an angle. You can accomplish this by using the Brace command. To do so, you'll need to load the rod (considered a family in Revit) into the model.

To use the Brace command, first add the rod family to your model.

1. Go to the Insert tab on the Ribbon.

2. Click the Load Family button.

3. Browse to Structural ➞ Framing ➞ Steel, and open the file Round Bar.rfa (or M_Round Bar.rfa).

4. Go to the North elevation in the Project Browser. Notice that grid lines A–F are visible in this view—very useful!

5. In the Properties panel for the North elevation, change Detail Level to Fine and Visual Style to Shaded.

6. Zoom in on the east canopy.

7. On the Structure panel of the Structure tab, click the Brace button, as shown in Figure 8.44.

8. Revit displays a dialog asking you to specify a work plane. In the Name drop-down list, select Grid : 1, as shown in Figure 8.45, and then click OK.

9. Verify that Round Bar: 1” (M_Round Bar 25) is the current framing member in the Type Selector.

10. Draw a diagonal bar, as shown in Figure 8.46. (I'll let you eyeball this one, or you can make the top offset a specific increment.)
11. Go to the Level 2 floor plan.

12. On the Quick Access toolbar, click the Section button.
13. Place the section along column line F, as shown in Figure 8.47, starting at point 1 and ending at point 2.
14. Open the section.

15. Rename the section Framing at North East Canopy.


17. On the Structure panel of the Structure tab, click the Brace button.

18. Choose Grid : F as the work plane. Click OK.

19. Draw a diagonal rod between the points shown in Figure 8.48, and press Esc.

20. Compare Figure 8.49 to your rods.

21. Mirror the rods to the other canopy. You can open the East elevation to do so.
22. Save the model.

That pretty much covers it for framing. The next section will bring you underground into the foundation. Although the structural engineer usually specifies the foundation system, architects must have access to foundation tools to place concrete foundation walls as well as to strip and isolate footings and piers. The next section addresses these topics.

**Understanding Foundation Systems**

The first question that arises while addressing structural foundations is, “What if the architect places a foundation in the model and then the structural engineer places one in their model?”

What will happen is the structural engineer will use a method called Copy/monitor, whereby the engineer takes the architect’s foundation and makes it
their own. The engineer is then free to alter the foundation. This method is addressed fully in Bonus Chapter 2, “Creating Families.”

This section focuses on creating foundation walls. Although adding this type of wall is similar to adding architectural walls, you need to be aware of a few things.

For now, let’s add a foundation and deal with coordination later. The task before you is to create a foundation wall constructed of 18” (450 mm) of solid concrete. To proceed, follow these steps:

1. Go to the Level 1 floor plan.
2. Click the Wall ➢ Wall: Structural button on the Structure tab. The same tool is on the Architectural tab.
3. In the Type Selector, in the Properties dialog, select Generic 8” Masonry (Generic – 200 mm).
4. Click the Edit Type button.
5. Click the Duplicate button.
6. Name the new wall 18” Concrete (450 mm Concrete), as shown in Figure 8.50.

Figure 8.50: Adding a structural wall
7. Click OK.

8. Just under the Wall Function row is the Coarse Scale Fill Pattern row. Change the hatch to Concrete by clicking the [...] button and selecting Concrete from the menu. Click OK.

9. Click the Edit button in the Structure row.

10. In the second row in the Layers chart, click in the Material cell.

11. Click the [...] button.

12. Find Concrete – Cast-in-Place Gray, and select it.

13. Click OK.

14. Change Thickness to 1’–6” (450 mm) by typing 1 6 (with a space between the numbers), as shown in Figure 8.51.

15. Click OK twice.

You’re about to place a wall under this level. This view is currently set not to show anything below this level, forcing you to alter the view range.

To modify the view range, follow these steps:

1. Press Esc twice, and then scroll down to View Range in the Properties dialog and click the Edit button.
2. For Primary Range, set Bottom Offset to -1’–0” (-300 mm).
3. For View Depth, set Level Offset to -1’–0” (-300 mm).
4. Click OK.
5. Start the Structural Wall command again.
6. On the Draw panel, click the Pick Lines icon.
7. Foundation walls are placed top down, so Depth rather than Height appears on the Options bar. Make sure Depth is set to T.O. Footing and Justification is set to Wall Centerline.
8. Pick the centerline of the exterior wall, as shown in Figure 8.52.

**Figure 8.52:** Picking the centerline of every exterior wall in the model. This includes the corridor and both wings.

9. Pick every exterior wall in all three sections of the model.

Your 3D model should look like Figure 8.53. Get into the habit of viewing the model in 3D, especially when you can't see exactly where the walls are being placed in the plan.
Now you can travel into the ground and check out how your walls are joining. Some cleanup will be involved.

1. In the Project Browser, double-click the T.O. Footing floor plan.
2. Zoom into the east wing area, where the north elevator meets the foundation wall. However, the walls are funky, as shown in Figure 8.54.
3. Select the left masonry elevator shaft wall.

4. Drag the end blue grip of the wall out so that it abuts the foundation wall.

5. The masonry wall to the right needs to be joined to the foundation wall. To do this, click the Join Geometry button on the Modify tab, as shown in Figure 8.55.

![Diagram showing the joining of walls](image)

**Figure 8.55:** Joining the walls so the foundation walls terminate as expected

6. Pick the foundation wall.

7. Pick the masonry wall. The masonry wall is notched back for the foundation.

8. Repeat the procedure for the south elevator. The condition may be slightly different from that of the north elevator, but the process to fix it is the same.

Moving to the west wing, you need to fix one wall. You’ll use the Split command, as follows:

1. Zoom in on the area, as shown in Figure 8.56.
2. On the Modify tab, click the Split Element button (see Figure 8.56).

3. On the Options bar, click the Delete Inner Segment check box.

4. Pick the points marked 1 and 2 in Figure 8.56, and press Esc twice.

Now that the foundation walls are in place, let’s think about what these walls are bearing on. Revit Architecture has tools to add footings to the bottom of the walls.

## Adding Structural Footings

If you’re going as far as placing structural foundation walls, you might as well continue and place footings under them, right? Luckily, this isn’t a difficult task.

Before you begin adding structural footings to the plan, you need to acknowledge that, by default, this view isn’t set up to see objects that are physically below its level. To correct this, you must alter the view range of this specific plan. Follow these steps:

1. Make sure you’re still in the T.O. Footing plan.

2. In the Properties dialog, go to the View Range row, and click Edit.
3. Set Primary Range Bottom to Unlimited.

4. Set View Depth Level to Unlimited, as shown in Figure 8.57.

![Figure 8.57: Again with the view range!](image)

5. Click OK.

6. On the Foundation panel of the Structure tab, click the Wall button, as shown in Figure 8.58.

![Figure 8.58: Adding a wall foundation](image)

At the top of the Properties dialog, it says Bearing Footing – 36" × 12" (900 mm × 300 mm). This is a little big for your purposes, so let’s make a new footing.

1. In the Properties dialog, click the Edit Type button.

2. Click Duplicate.

3. Call the new footing element Bearing Footing – 30" × 12" (Bearing Footing – 750 mm × 300 mm).

4. Click OK.

5. Change the Width setting to 2’–6" (750 mm), as shown in Figure 8.59.
6. Click OK again to get back to the model.

7. Start picking walls. This footing will be centered under each wall you pick. Ignore the elevator shaft walls.

8. When you’ve finished picking the walls, go to a 3D view to make sure all the foundations are covered, as shown in Figure 8.60.

Figure 8.59: Changing the width

Figure 8.60: Doing a 3D investigation to see whether the footings are all in place
When all the footings are in place, you can see that you need to focus on the elevator shafts. Because an entire foundation mat is required under the elevators, you can use a structural slab.

**Structural Slabs**

Structural slabs are basically thick floors. The one you’re about to use is a solid concrete floor 12” (300 mm) thick. Of course, Revit doesn’t have something this thick built in the library, so you’ll take this opportunity to make one. Here are the steps:

1. Go to the T.O. Footing floor plan.
2. Zoom into the elevator area.
3. On the Foundation panel of the Structure tab, choose Slab ➤ Structural Foundation: Slab, as shown in Figure 8.61.

![Figure 8.61: Choosing Structural Foundation: Slab](image)

4. In the Properties panel, click Edit Type.
5. Click Duplicate.
6. Call the new slab 12” Elevator Slab (300 mm Elevator Slab).
7. Click OK.
8. Click the Edit button in the Structure row.
9. In the Layers field, change Thickness to 1’–0” (300 mm), as shown in Figure 8.62.
10. Click OK twice to get back to the model.
11. On the Draw panel, verify that the Pick Walls button is selected.
12. On the Options bar, set Offset to 1–0” (300 mm).

13. Pick the three elevator shaft walls, as shown in Figure 8.63.

14. Set Offset back to 0.

15. Select the Pick Lines button. Verify that the offset is 0.

16. Pick the inside of the exterior foundation wall.
Now that the perimeter is set, it’s time to trim the edges to make sure you have a continuous, closed loop.

1. On the Modify panel, click the Trim/Extend To Corner button.
2. Trim any overlapping corners, as shown in Figure 8.64.

![Figure 8.64: Trimming all the corners](image)

3. On the Floor panel to the right of the Create Floor Boundary tab, click Finish Edit Mode.
4. Repeat the process for the south elevator.
5. Go to a 3D view.
6. If your slabs look more like a strip footing, as shown in Figure 8.65, hover your cursor over the inside of one of the foundations until the elevator shaft openings are highlighted.
7. Select the elevator shaft openings.
8. In the Properties dialog, change Base Offset to 0.

Your view should look like Figure 8.66.
**Figure 8.65:** Selecting the elevator shafts to remove the base offset in the Properties dialog

**Figure 8.66:** The finished elevator pads
With the footings mostly in place, you can think about placing piers and spread footings in the foundation. Luckily, as you’re soon to discover, you already know how to do this.

**Piers and Spread Footings**

Piers and pilasters, simply put, are concrete columns. This is how Revit sees these items, and the following is the easiest placement method. A nice thing about this technique is that the grids are in place as well as the steel columns that bear on them. The only real trick is deciding which plan to put them in.

The objective of the next procedure is to add pilasters to support the columns bearing on them. Follow these steps:

1. Return to the T.O. Footing plan.
2. On the Structure panel of the Structure tab, click the Column button.
3. On the Modify/Place Structural Column tab, click the Load Family button, as shown at the top of Figure 8.67.

![Figure 8.67: Starting to place piers](image)

4. Browse to Structural ➔ Columns ➔ Concrete.
5. Pick the file called Concrete-Square-Column.rfa (M_Concrete-Square-Column.rfa).
6. Click Open.
7. In the Type Selector, select the $24 \times 24$ (600 x 600 mm) column. Verify that Height is set to Level 1.

8. Begin placing columns at the grid intersections, as shown in Figure 8.67. Using At Grids can speed up your work.

9. Press Esc, and then go to Level 1.

10. Zoom into the corridor.

11. Move the piers under the columns that you moved before.

12. Do the same for the pier under the doorway, as shown in Figure 8.68.

13. Delete columns, footings, and piers D-1 and D-5.

Now you’ll add the spread footings under the piers. This process is almost identical to the previous one.

1. Go back to the T.O. Footing floor plan.

2. On the Foundation panel of the Structure tab, select the Isolated Foundation button.

3. No structural foundations are loaded into the project, so click Yes.


5. Select the file called Footing-Rectangular.rfa (M_Footing-Rectangular.rfa).
6. Click Open.

7. In the Properties dialog, click the Edit Type button.

8. Click Duplicate.

9. Call the new footing $36'' \times 36'' \times 12''$ ($900 \text{ mm} \times 900 \text{ mm} \times 300 \text{ mm}$).

10. Click OK.

11. Change Width to $36''$ ($900 \text{ mm}$).

12. Change Length to $36''$ ($900 \text{ mm}$).

13. Change Thickness to $12''$ ($300 \text{ mm}$).

14. Click OK.

15. Add these footings to each pier. The At Columns option on the Multiple panel works like At Grids and will speed up your work. Your foundation plan should resemble Figure 8.69.

**Figure 8.69:** The completed foundation

Having a foundation in place in an architectural plan can be both good and bad. It can be bad because structural items begin appearing in places you may not want to see them. The last procedure of the chapter involves isolating the structure from the architecture.
Using Structural Views

By creating a structural view, you essentially duplicate an architectural view and hide the nonessential items in that view. Sound easy? That’s because it is! But before you get started, you’re going to remove some structural views that Revit provided for you.

To create structural views, follow these steps:

1. In the Project Browser, find the Structural Plans category.
2. Select all the structural plans in that category, right-click, and select Delete to delete the plans.

Continue as follows:

1. In the Project Browser, go to Floor Plans, right-click T.O. Footing, and select Duplicate View ➢ Duplicate With Detailing, as shown in Figure 8.70. The new view opens.

![Figure 8.70: Selecting Duplicate View ➢ Duplicate With Detailing](image)
2. Rename the view called Copy of T.O. Footing to T.O. Footing Structural Plan.

3. In the Discipline category of the View Properties, select Structural from the list, as shown in Figure 8.71. The sections disappear.

4. In the Project Browser, right-click Views (All), as shown in Figure 8.72.
5. Select Browser Organization.

6. Select the Discipline option, as shown in Figure 8.73, and then click OK.

![Browser Organization](image)

**Figure 8.73:** Selecting Discipline

Now the Project Browser is broken into categories. This will be helpful for large projects with a mix of structure and architecture.

This is getting easy! Let’s make the Level 1 architectural plan truly architectural, as follows:

1. Open the Level 1 floor plan (architectural).
2. Scroll down to View Range.
3. Click the Edit button in the View Range row.
4. Change both the Bottom and View Depth offsets to 0.
5. Click OK.

The foundation information is no longer displayed in the Level 1 floor plan. Although the last part of this chapter was short, it’s a nice look into the Project Browser, and it shows how you can begin to get organized. If you would like more practice, go into the Project Browser on your own and organize it the way you’d like.
Chapter 8 • Structural Items

Are You Experienced?

Now you can...

✔ place a structural grid in your model by using the architectural walls as a reference

✔ add additional grids at a radius or by sketch where needed

✔ add columns to the grid lines

✔ add columns at an offset, keeping the relationship to the grid intersection intact

✔ add structural beams to the model

✔ add structural beam systems, which can follow centering rules or equal-distance spacing

✔ use the Brace command to create brace framing to be used for both architectural appointments and structural bracing

✔ create entire foundation systems complete with foundation walls, piers, and spread footings

✔ organize the Project Browser to show your model broken into disciplines

✔ change a view’s discipline to Structural